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Federal Communications Commission
Radio Frequency Interference Statement

The equipment described in this manual generates and uses radio frequency energy. If it     
is not installed and used properly, that is, in strict accordance with these instructions, it    
may cause interference to radio or television reception.

FCC I.D. Number: EY5QCSONICBLAST

This equipment has been type tested and found to comply with the limits for a Class B 
computing device in accordance with the specifications in Subpart I of Part 15 of the      
FCC Rules. These rules are designed to provide reasonable protection against radio and 
television interference in residential installation.

However, there is no guarantee that interference will not occur in a particular installation. 
If this equipment does cause interference to radio or television equipment off and on, the 
user is encouraged to fly to correct the interference by one or more of the following 
measures:

◊ Reposition the receiver’s antenna. Also make sure the antenna 
wires are making good electrical contact.

◊ Use a roof-mounted antenna rather than a rabbit-ear” antenna or 
an antenna mounted in the attic.

◊ Make sure that all electrical connections on the computer are 
secure and any shielded 110 cables are properly fastened.

◊ Move the computer away from the receiver.

◊ Plug the computer and receiver into separate electrical circuits.

If necessary, the user should consult the dealer or an experienced radio/television 
technician for additional suggestions. The user may find the following booklet prepared     
by the Federal Communications Commission helpful:

"How to Identify and Solve Radio-TV Interference Problems"

This booklet is available from the U.S. Government Printing Office, Washington, D.C. 
240402, Stock No. 004-000-003454

Warning: This equipment has been certified to comply with the limits for Class B 
computing device, pursuant to Subpart J of Part 15 of FCC Rules. Only peripherals 
(computer input/output devices, terminals, printers, etc.) certified to comply with the  
Class H limits may be attached to this computer. Operation with non-certified peripherals 
is likely to result in interference to radio and TV reception.

Applied Engineering is not responsible for any radio or television interference caused by 
unauthorized modifications to this equipment. It is the responsibility of the user to        
correct such interference.
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Limited Warranty & Disclaimer
                                                                                                                                                        
Applied Engineering warrants the Sonic Blaster card against defects in material and workmanship for a period of 5 
years from the date of original retail purchase. Applied Engineering also warrants that, under normal use, the  
magnetic media on which the included software is stored is free from defects in materials and workmanship for a 
period of 30 days from the date of original purchase. Any misuse, abuse, or non-Æ authorized alteration,   
modification and/Or repair to the Applied Engineering product will void the warranty. This warranty will also be void if 
you use the Æ product for any other purpose than its intended use. If you discover a defect, Applied Engineering   
will, at its option, repair or replace only the Applied Engineering product, provided you return the product during the 
warranty period. transportation prepaid. to Applied Engineering.

This warranty applies to the orIgInal retaIl purchase only. Therefore, please include a copy of the         
original invoice or a small service charge may be applied. If the product is to be sent to Applied Engineering by mail, 
the purchaser will insure the package or assume full responsibility for loss or damage during shipping. Prior to  
returning the product for warranty consideration, call Applied Engineering Technical Support for a Return Material 
Authorization (RMA) number and shipping instructions.
                                                                                                                                                       
Even though Applied Engineering has tested the software and reviewed the documentation, Applied Engineering  
makes no warranty or representation, either express or implied. with respect to the manual or the software; their 
quality, performance, merchantability, or fitness for a particular purpose. As a result. the software and manual are 
sold as is.’ and you, the purchaser, &e assuming the entire risk as to their quality and performance.

In no event will Applied Engineering be liable for loss or damages of any kind caused either directly or indirectly by the 
use or possession of its products, even if advised of the possibility of such damages. The Applied Engineering 
Warranty is for the Applied Engineering Product itself. In particular, Applied Engineering shall have no liability for any 
other equipment used in conjunction with Applied Engineering products nor for programs or data stored in or used with 
Applied Engineering products, including the costs of recovering such equipment, programs, or data.

The warranty and remedies set forth above are exclusive and in lieu of all others, oral or written, express or implied. 
No Applied Engineering dealer, agent, or employee is authorized to make any modification, extension, or addition to 
this warranty.
                                                                                                                                                       
ml. manual and the software (computer programs) described herein are copyrighted by Applied Engineering with all 
rights reserved. Under the copyright laws, this manual or the programs may not be copied, in whole or in part, without 
the written consent of Applied Engineering, except in the normal use of the software or to make an archival copy. 
This exception does not allow copies to be made for others, whether or not sold, but all of the materials purchased 
(with all archive copies) may be sold, loaned, or given to another person. Under the law, copying includes translating 
into another language or format. You may use this software on any computer owned by you but extra copies cannot 
be made for this purpose.

Applied Engineering cannot guarantee that you will receive notice of revisions to the software, documentation, or 
products described in this manual. Be sure to check with your dealer or Applied Engineering for information on  
possible updates. However, Applied Engineering reserves the right to make any improvements to Applied    
Engineering products without any responsibility toward upgrading previously released products.
                                                                                                                                                       
Apple and Apple los are registered trademarks of Apple Computer, Inc.
ProDOS and GS/OS are trademarks of Apple Computer. Inc.
Applied Engineering is a registered trademark of Applied Engineering.
Sonic Blaster and RamKeeper are trademarks of Applied Engineering.
Radio Shack is a registered trademark of Tandy Corporation.
Zany Golf is a trademark of Electronic Arts. Tomahawk is a trademark of DataSoft. Forth and Inches is a trademark
of Accolade. Silent Service is a trademark of Microprose. Winter Games is a trademark of Epyx, Inc.
                                                                                                                                                       

©Copyright 1988.1990 Applied Engineering 080390
                                                                                                                                                       

Applied Engineering
P.O. Box 5100

Carroliton, Texas 75011
Sales; (214) 241-6060 9AM - 11 PM (CST) 7 days

Technical Support: (214) 241-6069 9AM - 12:30& 1:35 - 5 PM (CST) Monday-Friday
(The Technical Support telephone lines cannot be accessed through the Sales department.)
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INTRODUCTION

What You Have

The Board
Welcome to the world of...

        

SOUND!

The Sonic Blaster is an audio digitizer and playback system.
Once installed, your IIGS thunders into a whole new dimension.
You've seen the GS incredible graphics, now hear its powerful
roar.

The board is easy to install. It will work in slots 1, 2, or 6. 
External connections are provided so you can quickly and easily 
connect line inputs and speaker outputs.

The Software
Connect your CD player, phono, tuner, tape player, VCR, or 
microphone to the external input connector and record pieces of 
your favorite songs, TV shows, or noises you make with your 
own mouth, hands, nose, pets, etc.

The included Super Hi-Res software lets you digitize in mono or 
stereo. Variable record and playback rates as well as volume 
setting are also provided in the control panel.

But wait! There’s more...

Audio Art, the second disk, contains an aural spectrum of 
sounds. We’ve pulled several files from Æ’s vast “library o 
sounds” and put them on disk for you. Feel free to make 
modifications to these files but make a backup copy of this disk 
first to keep the original files in their pure form.

The Manual
Notes and warnings throughout the manual will help you to 
better understand what you’re dealing with. They appear as 
shown in the example following;

Introduction . What You Have V
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Note: This indicates a special note or warning. Pay close 
attention to these entries.

Sonic Blaster is the full name of the product. In this manual, 
we’ll sometimes call it SB for short.

Part I, Sonic Blaster--The Hardware, describes the card, tells you 
what you need to use it, and takes you through the installation 
of the Sonic Blaster.

Part II, Sonic Blaster--The Software, begins by giving you a quick 
run through of what the Sonic Blaster software can do. The rest 
of the chapters in the section detail each menus options. The 
chapters are in the same order as the menus for easy reference.

The Appendices tell you how to copy the SB program to your 
RAM, ROM, or hard disk, how to work around problems you 
may encounter, what adapters you may need, and more.

The Glossary contains most of the terms used in the manual 
with which you may not be familiar.

Any comments or suggestions regarding this manual or any 
other ,~ manual, will be greatly appreciated both by Æ and by 
others who use our products.

Please address any comments or suggestions to:

Applied Engineering
P.O. Box 5100
Carrollton, Texas 75011
Attention: Manager, Technical Publications

vi Sonic Blaster
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Sonic Blaster

- - The Hardware
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CHAPTER ONE

Getting Started

What You Need
To effectively use the Sonic Blaster, you need:

◊ A IIGs with at least 512K expanded memory (768K total).

◊ A pair of  external  speakers ; amplified or non-amplified 
will work. The Sonic Blasters sound will actually come 
out the GS’ speaker but to really get the thumping stereo 
sound, you’ll need stereo speakers.

Some external speakers are amplified. Some have 
volume controls. If you don’t already have a pair of 
speakers to connect to the Sonic Blaster, shop around for 
a pair that give you the sound you want.

If you have a stereo tuner, you can connect the tuner to 
the Sonic Blaster and control the speaker volume with 
your tuner.

◊ Some adapters  may be required to allow your speakers to 
connect to the Sonic Blaster’s mini stereo plug. 
(Appendix C details some of the adapters available at 
any Radio Shack®.)

◊ A Phil lp's  screwdriver  is the only tool you’ll need to 
install the Sonic Blaster.

Where It Goes
We recommend installing the Sonic Blaster into slot 2. You can 
also use it in slot 1 or slot 6. It will also work in slot 5 but most 
GS users access the 3.5” drive through this port.

Decide which slot you’ll put the Sonic Blaster into according to 
how you want to use it and your current use of the slots.

Playback Only

If you want to use the card for stereo playback only, you can put 
the card in slots 1-6 without changing the Slot setting to “Your 
Card”. For example, you can insert the card into slot 5, leave the 
Slot setting set to “Smart Port” and still play back sounds from 
games, music software, and the Sonic Blaster software.

Ch. 1- Getting Started 3
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Recording and Saving Changes

To record or save changes to a file using the Sonic Blaster
software, you should install the card in slot 1, 2, or 6 and set the
Slot option to ‘Your Card.’ If the Slot option is not set to ‘Your
Card” the software will give you the error message, “Requires
AE Sonic Blaster Card” because it cannot “see” the Sonic
Blaster card.

◊ If you’re not using slot 6, put the card in there and leave 
the Slots option set to “Your Card”

◊ If you have an external modem connected to the GS

modem port, put it in slot 2 and toggle between the
Sonic Blaster and the modem with the Control Panel’s
Slots option.

◊ If you have an internal modem and a printer connected 
to the GS’ printer port, put it in slot 1 and toggle between 
Sonic Blaster and the printer with the Control Panel’s 
Slots option.

 
The Slots option setting will be discussed more in step 12 of the 
next chapter.

RamKeeper Users
You’ll need to take your RamKeeper out of its slot during the
installation. Before beginning the installation, back up your
ROM disk and disconnect both the transformer and the battery.
You will not need to remove the RamKeeper’s connector plate.
The rest will be explained in Chapter 2.
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CHAPTER Two

Putting It In

1.)    TURN OFF THE APPLE’S POWER SWITCH. Never
install or remove a card while the computer is on. 
However, you need to leave the computer plugged in 
throughout the installation to allow the power supply to 
discharge static electricity from your body.

2.) Remove the cover from the Apple. Press in the two 
latches in the rear of the case with your forefingers 
while using the heel of your hand to pull the lid up and 
towards you. (See below.)

3.) Touch the power supply to remove any static electricity 
from your body. Do not skip this step! A static shock 
can damage the chips on your card and/or the chips on 
your computer’s motherboard.

      Remove the IIGS cover        Touch the power supply case

4 . ) Remove the  plast ic  plate  from the backplane if it still 
covers the large opening closest to the slot in which you
plan to install the Sonic Blaster. If this opening is 
already being used, you may need to do some 
rearranging; the hole must be close enough to the card 
for the SBs backplate connector to reach.
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       Remove the plastic plate

5) Remove the Sonic Blaster from its anti-static bag. Hold 
the card by its edges, like a photograph.

6) Plug the card into slot 2, 1 or 6 (in order from most 
recommended to acceptable) by inserting the fingers of 
the circuit board into the slot. The fingers will enter the 
slot with some friction, and will then seat firmly.

6 Sonic Blaster - The Hardware
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7) Connect the mounting plate to the opening in the back 
panel using the hardware provided. Partially insert one 
screw into the bottom hole of the connector then slide 
this screw over the notch at the bottom of the opening. 
Make sure the writing (“OUT” and “IN”) is right side 
up. Insert the top screw and tighten both screws.

* Notes The six-pin female connector at the end of the 
mounting plate cable should be connected to the six-pin 
connector on the SB. Make sure it is still firmly 
connected.

Partially Insert bottom screw              Connect the plate
(lettering should be upright)

* Important! You must connect the mounting plate to the 
back panel of the computer for proper grounding. If you 

 do not, Sonic Blaster cannot function properly.  

8) Now attach the loose end of the Ensoniq Input/Output 
(E-I/O) cable to the seven-pin audio connector on the 
IIGS motherboard. The cable is keyed so that it will fit 
easily in one direction only.

Ch. 2 - Putting It In    7
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                     Connect the E-I/O cable to the motherboard

8a) If you have a card in the Memory Expansion slot, you 
may need to remove it to plug in the E-I/O cable. In the 
case of RamKeepers, be sure to back up your ROM disk 
before unplugging the transformer and battery. You 
don’t need to unscrew the RamKeeper’s Connector plate; 
simply remove the RamKeeper from the Memory 
Expansion slot and then plug in the cable. Don’t 
reinstall the RamKeeper yet.

8b) If you’ve taken your RamKeeper out of the slot, reinsert 
it now. Make sure that the insulator is still in position 
before reconnecting the power. At the end of the SB 
installation, follow the directions in the RamKeeper 
manual for setting up the ROM disk.

8c) The other end of the E-I/O cable should be connected to 
the seven-pin connector on the SB. Make sure it is still 
firmly connected.

9) Connect the line from your speakers or stereo amplifier 
to the SB’s “OUT” connector on the back of your IIGS. 
(The cable from your speaker or amplifier may require 
an adapter to connect to Sonic Blaster’s stereo mini plug. 
See Appendix C for adapter information.)

10) Set the card’s volume pots located along the top edge of 
the card.

8 Sonic Blaster - The Hardware
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There are several ways to control the Sonic Blasters 
output volume. The different methods are explained 
more in the following section, “A Note About Volume 
Control.’ Right now, however, you’ll need to Set the 
volume on the card itself:

◊ If you have an amplifier connected or if you’re using
amplified speakers, turn the volume on the card up a
very little bit. The arrows will be pointed almost
straight left. (See illustration following.)

◊ If you don’t have an amplifier or amplified speakers 
connected, set the card’s volume to about one-quarter. 
The arrows will be pointed to the left at about 315˚. (See 
illustration following.)

Volume Pots     Volume Pots
set to low Cables to Connector set to medium Cables to Connector 

                 Plate Plate

    Volume setting                       Volume setting 
w/ amplifier connected           w/o amplifier connected

11) Replace the Apple’s cover.

12) Now, use the Control Panel to set the slot setting for the 
Sonic Blasters slot to, “Your Card.”

If you plan to use the Sonic Blaster for playback only, 
you can skip this step. (Refer to the section “Where It 
Goes” on page 1 for details.)

If you don’t know how to change the settings in the 
Control Panel, refer to your Apple IIGS Owner’s Guide 
for instructions on setting the slot using the Control 
Panel.

Ins ta l la t ion  i s  comple te !

Ch. 2 -  Putting it in         9
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A Note about Volume Control
Rarely will you want to turn up the Sonic Blasters volume pots 
all the way. The settings described in step 10 should provide you 
with a good top-end volume.

Control the volume range with the volume knob of your 
amplifier (if connected) or the volume knob of the speakers (if 
equipped).

Most well-written games and sound programs will allow you to 
control the volume from inside the program. If not, control it 
using the methods above.

The volume setting in the IIGS Control Panel will control the 
output of the GS internal speaker and earphone jack but will 
have no effect on speakers connected to the Sonic Blaster 
connector.

Now What?
Now your Sonic Blaster is ready to 

Boot up your favorite GS-specific game and hear the roar. The. 
Sonic Blaster greatly enhances the sound of GS games and other 
programs that use the Ensoniq chip. Such games as 
Tomahawk™, Zany Golf™, Silent Service™, Fourth and Inches™ 
and Winter Games™ take on a whole new dimension when 
played through Sonic Blaster.

Boot up the included Super Hi-Res software to put the card 
through its loops. Sonic Blaster’s software is very easy to use but 
you’ll probably want to at least read the Introduction of Part II to 
get an idea of what it can do.

10 Sonic Blaster - The Hardware
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PART II
Sonic Blaster

-- The Software

Part II - The Software         11
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INTRODUCTION

Start, Look, and Listen

Sonic Blaster’s software has a Mac-like interface that makes the 
program’s use extremely intuitive. If you’ve experienced the GS’ 
Finder or if you’ve ever used a Macintosh before, you’ll be 
familiar with many of the menu options and how to use them.

You should already be comfortable with such phrases as “Click 
and Drag,” “Full-Down Menus,” “Select,””Eat all your 
vegetables,””I have to wash my hair,” and “Can you hold?’---. 
If the first three terms sound foreign to you, you’ll need to refer 
to the IIGS User’s Manual or the IIGS Guided Tour disk that were 
provided with your computer.

About the Sonic Blaster Disks

The startup disk contains the GS/OS files necessary to run the 
program and access your disk drives. The entire GS/OS system 
is not included. We recommend that you see your Apple dealer 
for upgrading to GS/OS if you don’t have it already.

The second disk, Audio Art, contains several sound files we’ve 
made for you to experiment with.

Running the Software

Before you run the software, do the following:

1) Make a copy  of the Sonic Blaster disk.

Use either System Utilities (included on your GS System disk), 
the Finder, Filer or your favorite copy program to make the copy.

* Note: From here on, when we refer to the Sonic Blaster 
disk, we mean the COPY you have just made.

2) Copy the program to your hard disk, ROM disk or RAM
disk if you plan to run it from any of those locations.

For information on loading the program to your ROM 
disk, RAM disk, or hard disk see Appendix A.

3) Format several disks under ProDOS so you’ll have a 
place to save your “work.” (Sonic Blaster does not 
support formatting.)

Intro. - Start, Look, and Listen 13
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Booting the Software
From the Startup Disk

1) Insert the Sonic Blaster startup disk into your boot drive.

2) Turn on the computer.

3) The disk will automatically load the SB software.

From the Finder

I) With the computer on and the Finder loaded, insert 
your Sonic Blaster startup disk into a 3.5” drive.

2) Double-dick the disk icon to open its window.

3) Double-click the icon SONIC.SYS16 to run the 
application.

Other Launchers

Follow the instructions for the launcher you use to run the 
application SONIC.SYS16.

Sample Session
Following is a short example of how you can use the Sonic 
Blaster to play back and edit sound files.

To play a sound file

I) Click and drag down the File menu until the Open 
option is selected and then release the mouse button.

This opens a catalog of your current online disk.

2) If the Audio Art disk is not the current disk cataloged, 
make sure it is an accessible drive, and then click on the 
“Disk button until its name appears above the catalog 
wind ow.

3) Double click on any sound file in the catalog window 
called to open that file.

You can also open the file by clicking once on the filename to 
highlight it and then clicking on the Open button.

4) The software will tell you that it is loading the file and 
will display a bar showing you what proportion of the 
file has been loaded and how much is left to load.

5) When the file is loaded, you will see the sound graph at 
the bottom of your monitor.

14 Sonic Blaster - The Software
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The sound graph is a visual representation of your files sound 
wave. The pathname of the sound file is displayed at the top of 
the sound graph window.

6) Click on the Play button.

The sound file you have loaded will now play.

Repetitive Play, Volume and Rate

1) Click the Continuous Play button then press Play 
again.

The file will play over and over again.

2) While the file is playing, click and drag the "thumbs" 
(white squares) under the Volume and Playback 
Sample Rate headings to vary the volume and speed.

* Note: You can also click on the arrows at either end of 
the bars to change Volume, Playback Sample Rate, etc.

3) Click Stop (or press option-S) when you’re ready to 
move on.

Effects

1) Select a section of the file by clicking and dragging 
within the graph.

The section selected will have an inverse background and wave 
pattern from the rest of the graph. Push Play to hear the 
selection.

2) Click and drag down the Effects menu.

3) Try out the different options; select Backwards  then 
click Play again, select a different section (by clicking 
and dragging) and Echo it, Fade Up another selection, 
keep go ing, get crazy, have some fun...
keep going, g-g-g-get cra-cra-cra-crazy, evah some fun, fun,
 fun, fun, fu...

4) When you've jumbled up the selection beyond 
recognition, dose it by either clicking on the small box 
in the upper left corner of the graph window or by 
selecting Close from the File window.

* Note; When you close a window you’ll be asked if you 
want to save changes to that file. Click No to leave the 
file in its original form. If you want to save your 
changes, select Save As from the File menu and give 
your audio art a name.

Intro. - Start, Look, and Listen       15
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What’s Next?
Use the rest of the manual as reference. The next chapter gives a 
detailed description of the screen contents. The rest of the 
chapters in Part II itemize and describe each of the options 
offered in the menus in the order in which they appear starting 
with the File options and proceeding to the right.

The Appendices offer everything from instruction on how to 
load the program to your RAM, ROM, or hard disk to some 
information about adapters you may need and their catalog 
numbers.

16 SonIc Blaster - The Software
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CHAPTER ONE

The Screen
           File    Edit   View   Effects   Setup   Sounds

                                   /AEROM/SOUNDS/SAMPLE.SESSION

The Sonic Blaster Screen  

* Note: SAMPLE. SESSION is not an included file.

The Sonic Blaster screen presents you with a super-simple 
interface and a wealth of information.

The Sound Graph

The sound graph is the window at the bottom of the screen. It 
contains the sound wave of the sound file currently selected.

The Select Bar

The select bar, the straight flashing line within the sound graph, 
lets you choose the part of the file you want to work with.

->      You can play the entire file when the select bar is
flashing (nothing is selected) or by choosing Select 
All ( -A) from the Edit menu.

-> To play only a small portion of the file, click and drag 
over the portion to select it and then click Play.

-> Select from the beginning of the graph to the pointer
position by holding down the command ( ) key while 
clicking the mouse.
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-> Select from the pointer position to the visible end of the 
graph by holding down the option key while clicking the 
mouse

-> Extend your selection to the left or right without 
changing your anchor point by holding down the shift 
key while dragging the pointer to the left or right.

The Keyboard Help... option under the Apple menu 
presents you with a quick reminder of what the mouse/keyboard 
commands are. (See graphic following.)

Stop, Play, Pause, and Record

The Stop, Play, Pause, and Record buttons perform the same 
functions as they do on a tape recorder. Click on the buttons 
above the word to begin that function. The keyboard 
alternatives for all four functions are given in the Keyboard 
Help menu. (See below.)

Keyboard Help
Player Controls: Play (option) P

Stop (option) S
Pause (option)W
Record (option) R

These keys can be used along with mouse selection
Extend selection (shift key
Select to end (option)
Select from  beginning (command)

Keyboard Help window

Stop, Play, and Pause affect the currently displayed sound file.
Record opens a new file called, Untitled# (where # is a
sequential number) into which it places the inputed sounds.
Before recording:

1) Go to the Setup menu to set your Record Channel 
option for mono or stereo record,

2) Set your record level automatically using Auto Gain
(under the setup menu) or set it manually using the
VU meters and Record Level bar on screen or the
Oscilloscope screen (under the View menu).
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3) If you have several windows open, you may want to 
close them (save if desired) to compress the available 
memory and get a larger Max B lock onto which you can 
record.

* Note: While recording, the GS will be completely 
occupied with digitizing; all other functions (VU meters, 
mouse, etc.) are disabled.

The Cassette Label
The number on the cassette label tells how many bytes the file 
occupies in memory. When working with stereo files, the 
cassette label gives the combined bytes for both Channel 1 and 
Channel 2. The SAMPLE.SESSION file shown above is 38,152 
bytes -- about 38K.

Single Play/Continuous Play
If you want the selected portion to play only once, select the 
Single Play button. If you want it to play in a continuous loop, 
click the Continuous Play button.

VU On/VU Off
The VU meter is a visual representation of the input levels 
being sent from the device you have connected to the Sonic 
Blasters IN connector. Turn it On or Off by clicking the 
appropriate button. Use the VU meter in conjunction with 
Record Level to get the best sound. (See Record Level 
following.)

Volume
The Volume bar lets you control the amplitude of the playback. 
The volume will also be affected by the position of the volume
knobs on the SB and any amplifier you may have connected.

Playback Sample Rate
The Playback Sample Rate bar lets you control how fast or slow 
(in Hertz) the file is played back. You can change this setting 
even while in play mode. If the sound file you load in contains 
the information about the speed at which it was originally 
recorded, the Playback Sample Rate will be set accordingly. If 
the file contains only raw data, playback will be set to the default 
setting of 22,085 Hz. You can then adjust the rate until it sounds 
correct and save it in a format that will remember the playback 
rate you have set; AE, AIFF, 2:1, or 2.67:1 formats all save the 
playback rate information with the file.
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Record Sample Rate
Record Sample Rate bar allows you to set the Hz at which you 
record. A higher Sample Rate means a higher quality recording 
produced and a larger memory block used.

In general, voice recordings require lower sample rates (7,000 
and up) while music (especially from CD’s) require higher 
sample rates (we recommend the maximum, 15,184 for stereo 
and 30,368 for mono).

Record Level
Record Level adjusts the input level from your source 
connected to the Sonic Blasters IN connector. The record level 
should be set so that the VU meter bars bounce up to but do not 
continuously bang against the top of their columns.

Record Level allows for a broad range of input--anything from 
mike level (low level input) to line level input (medium) to 
speaker level (high).

You can also set the record level from the Oscilloscope option 
under the view menu or have Sonic Blaster set it for you 
automatically with the Auto Gain option under the Setup 
menu. Both of these option are explained in their respective 
chapters.

Play Time
Play Time shows how long, in seconds, the currently displayed 
file is.

Max Block
Max Block shows the amount of contiguous (unfragmented) 
memory available to the program at any given time. Notice that 
the amount of memory available will decrease slightly as you 
open the menus. This is because their images are being loaded 
into RAM for faster access. The Max Block number is important 
to know because this tells you the largest recording you can 
make.

* Note:  If the Max Block doesn't seem to be increasing as 
you close files, it is because a file that is still open is held 
into a certain place in memory. For best memory 
allocation, close (and save if desired) all windows and 
then reopen only the ones with which you want to work 
or begin your recording.
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Select Region

Select Region tells you how many bytes you currently have 
selected. In the example screen, the selected area is bytes.

If you’ve selected the entire window (by choosing Select All 
[ -A] or by dragging across the entire wave when set to Full 
view), and the number on the cassette label is slightly different 
from the number in the Select Region, don’t worry; this is due 
to rounding. If the number on the label is about twice the 
number of the Select Region, you’re working with a stereo file; 
each channel is half of the entire file’s value.

Resolution

Resolution is a ratio of how many sound samples per screen 
pixel are being displayed. 1:1 means that every horizontal pixel 
in the sound graph represents one sound sample. Resolution 
will vary from file to file and changes (by a factor of 2 or .5) as 
you use the Zoom In/Zoom Out options under the View menu.
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CHAPTER Two

The “File” Options

Click and hold on the File menu on the left side of the menu 
bar. You'll be presented with the following options:

New ( -N)
The New command creates a sound graph at the bottom part of 
the screen with the name Untitled# (where # is an appended 
number). New graphs are a good scratchpad on which to 
combine different sound files. The new sound graph will have 
626 bytes of silence when in mono mode or 1252 bytes of silence 
in stereo mode. (Choose between mono or stereo with the 
Record Channel option under the Setup menu before opening a 
new window.)

You’ll almost always want to get rid of the silence by choosing 
Select All ( -A) before pasting in a section you have copied or 
cut from another file.

* Note: The program automatically opens a new, empty 
window when you record. Before recording:

1) Go to the Setup menu to set your Record Channel 
option for mono or stereo record,

2) Set your record level automatically using Auto Gain
(under the setup menu) or set it manually using the
VU meters and Record Level bar on screen or the
Oscilloscope screen (under the View menu).

3) If you have several windows open, you may want to 
close them (save if desired) to compress the available 
memory and get a larger Max Block onto which you can 
record.

Open ( -O)
The Open command allows you to load a prerecorded sound file 
stored on disk.

* Note: Because sound files are memory intensive, they 
take longer to load than do text files. You will find the 
load time greatly decreased by copying the files to and 
loading them from a RAM or ROM disk.
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For more information on ROM disks, see "RamKeeper" 
in the glossary.

For more information on RAM disks, refer to your IIGS 
Owner’s Manual.

Append.. .
The Append option will open a file and stick it beginning-to-end 
with the currently open file automatically and seamlessly. This 
option gives you the ability to load a single file as large as your 
memory allows instead of limiting the size of the file to the size 
of a single floppy disk.

Use this option to quickly piece back together a file you have 
stored to different disks or to stick together two different files 
without having to: I) open, 2) select all, 3) copy, 4) change 
windows, and 5) paste.

The first file opened will determine the playback setting for the 
appended files and whether the file will be stereo or mono.

-> If you open a stereo file and then append a mono file to 
it, the mono file will be split into two channels (not true 
stereo but split mono).

-> If you open a mono file and append a stereo file to it, the 
two channels of the stereo file will be combined into one 
mono channel.

Close ( -W)
Close a file with this command or by clicking on the square in 
the upper left corner of the sound graph window.

If you have made changes to the file without saving them, a 
dialog box will appear asking if you want to save changes to this 
file before closing.

Click No’ to keep the file as it was when loaded or as it 
was when it was last saved.

Click Yes’ to save the file in its current state. 

Click Cancel to stop the ‘Close’ and return you to the 
program with the file still loaded.
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Save ( -S)

Use this option to save changes you have made to a file, if you 
have just created the file, you will be presented with the Save 
As.. . dialog box (see Save As... below), if you made changes to a 
file that already has a name, the file will be saved under the 
same name.

* Note: If you try to save changes to a locked file you’ll be 
told that the file is locked and asked if you want to 
replace it with the new information anyway. If you 
answer Yes, the new file will replace the old and the file 
will be locked again. If you select No, no save will be made.

Save As...
Save As... gives you a chance to name an untitled file or save 
an already named file with a different name and /or under a 
different format.

When this option is selected, you’re shown a dialog box like the 
one shown below:

        Current Disk 

  Catalog Window

       File Formats

Save as screen

Scrol l  through the  disk  catalog  by moving the thumb in the 
scroll bar or by clicking on the up or down arrows.

Disks online will be displayed in turn as you dick this box. The 
name of the currently selected disk is displayed at the top of the 
catalog screen (AEROM/SOUNDS in the example above). The 
amount available and total amount are also displayed (551 free 
out of 3199 in the example).
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If the disk you want to save to is not currently online, eject a 
disk, that is, if no other drive is available, and insert the correct 
disk into the drive. The disk will be found as you circulate back 
through the online disks.

* Note:   If you discover that there is not enough room on 
your data disk to store the file, you can save to another 
formatted disk or Cancel  the Save and make more 
room on the disk by using Delete from the Edit menu 
to get rid of any unwanted files. If the file is too large to 
fit on a single floppy, you’ll need to break it up into 
several files and save to multiple disk. Refer to App. E 
for instructions.

New Folders can be created with the name that is in the title box 
when you click the New Folder option. If a file or folder already 
has that name, a new folder will not be created. Once the folder 
is created, you can double click on it to open, name your sound 
sample, and then save it in the new folder.

Open  folders by selecting them in the catalog window and 
clicking this button or by double clicking on them in the catalog 
window.

C l o s e  the folder you currently have open by clicking this 
option or by clicking on the pathname located above the catalog 
window.

Save  the sound file by the name that is currently in the Save 
Wave As: box when you click this button. The file will be saved 
to the directory currently selected in the format selected.

* Note~ As stated earlier, if you try to save changes to a 
locked file you’ll be told that the file is locked and asked 
if you want to replace it with the new information 
anyway. If you answer Yes, the new file will replace the 
old and the file will be locked again. If you select No, 
no save will be made.

Cancel returns you to the edit mode.

Formats Recognized
The Sonic Blaster software lets you play and save sound files 
from and to many different formats. It uses it’s own format 
(AE), Apple’s standard sound file format (AIFF), Raw Data 
format (straight binary form), and 2:1 and 2.67:1 compressed.

26 Sonic Blaster -The Software

Download from Www.Somanuals.com. All Manuals Search And Download.



AF Format is Sonic Blasters own filetype. This is the default 
format for saving files. You’ll save the file you want to use as 
your startup sound in this format.

AIFF Format is the Apple Standard format.

2:1 Compressed is a format which does some squeezing to save 
the same amount of information in half the space.

2 .67:1  Compressed  same as above but compacting even more. 
This difference between 2:1 and 2.67:1 will be most noticeable on 
very large files.

The most noticeable difference between a compressed files and a 
non-compressed file is the amount of space it takes to store the 
file. Another difference is that the fidelity may be slightly 
decreased by the compression. The quality loss is very slight, 
especially in the case of voice recordings. Try saving a file in 
both the compressed formats and compare disk space used and 
quality with the original.

Raw Data is a mono file saved in straight binary format. This 
means that information, such as the speed at which the file was 
recorded, is not saved in this format. If you’re saving a file 
recorded in stereo as raw data, the two channels will be 
combined into one channel and saved as a mono file. When 
raw data files are loaded, the playback rate is set to the default 
setting of 22085 Hz.

* Note:  If you plan to use a program or desk accessory that 
plays back sound files, other than the ones provided 
with the Sonic Blaster, you’ll need to find Out the 
program’s or desk accessory’s default playback rate (if it 
does not let you set the playback rate) and record your 
sound files at that speed before saving as Raw Data.

Try saving the same file in the different formats and then play 
them back and check the amount of memory used to determine 
if you can tell a difference.
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Delete. . .
Delete is extremely useful for getting rid of files you no longer 
want in order to make room for new files. When you choose 
Delete, you’ll be presented with the open screen. However, the 
Open button is now the Delete button. Choose the disk that 
contains the file you want to delete. If the file is in a folder, 
double click on the folder to open it. Click on the file to delete 
and then click Delete. You’ll be asked if you want to delete the 
file you’ve selected ~a safety precaution). Click Yes to delete or 
No to return to the main screen without deleting the file.

* Note~ If you click on a folder and then click Delete, the 
folder will simply be opened, not deleted. Files can be 
deleted only one at a time.

Print (  -P)
The Print option presents you with the standard IIGS Print dialog 
box.

Set to this mode for print

of graph

Does not apply

Set page range to “All"
Choose this setting to

Soled how many copies print only pathname and

you want to make resolution

Set to this mode for Set to this mode for

tractor-feed paper single-feed paper

Dialog box for Print option      

Sonic Blaster will print the sound graph, the file’s title, and the Resolution 
factor.

Page Setup
The Page Setup option, when selected, displays the standard IIGS 
Page Setup dialog box.
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Select size of paper 
you're using

Select to print 1/2 size
Select “Condensed” for 
sharpest printout

           Does not apply
Prints vertically

Prints horizontally

Dialog box for Page Setup option

Choose Printer...
Lets you specify your printer arrangement. Select the printer you 
have online, the port to which it is connected and whether it is 
an AppleTalk connection or a direct connection.

Click on printer you're 
using

Click on port to which 
printer is connected

Click on connection 
you're using.

Dialog box for Choose Printer option
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CHAPTER THREE

The “Edit” Options

Undo ( -Z)
After you’ve made a change to the file, you can select Undo to 
cancel the most recent modification. The Undo command will be 
followed by the most recent option you’ve selected, for example, 
Undo Paste or Undo Echo . If Undo isn’t an option for the change 
you’ve made, the undo command will be dimmed.

Cut ( -X)
After you’ve selected a portion of the graph, choose Cut to 
remove the selection from the screen and copy it to the GS 
clipboard. You can then paste it to another location on the same 
file or to a different file. The selection will remain in the 
clipboard until something else is pasted in to take its place or 
until you quit the program.

Copy ( -C)
Choosing Copy when a portion of the file is selected will copy 
the selection to the clipboard without removing the selection 
from the screen.

Paste ( -V)
Selecting Paste copies the current contents of the clipboard into 
file at the selection bar position. If a section of the file is selected 
when you choose paste, the clipboard contents will replace the 
selection. If a selection was recorded at a different rate from the 
file you paste it into, the pasted selection will be played at the 
rate of the file into which you paste it.

A Note about the Clipboard

The Sonic Blaster’s clipboard is a local clipboard; it can be used 
only for the Sonic Blaster program. Once you quit the program, 
whatever you currently have pasted to the clipboard is lost.
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Mixing
Mix Settings and Mix enable you to Join selected portions of 
files together. A sound segment copied to the clipboard can be 
mixed with the selected portion of an active file. Use the SB’s 
mixing capability to create background noises for your files. You 
patriotic music in the background of a presidential speech or add 
subliminal messages to muzac.

Mix Settings

The Mix Settings option lets you choose how loud you want the 
clipboard in relation to the currently selected sample.

To use the Mix Settings option, follow these steps:

1) Select Mix Settings to display the dialog box below.

Mix Settings dialog box

2) Use the Set Mix Ratio slide bar to determine the 
amplitude ratio of the sample currently in the clipboard 
to the sample currently selected in the active window. 
If you want the clipboard sample to be as loud as the 
window segment, you would split the Mix Ratio bar to 
50/50. If you want the clipboard sample to be 
background and the window sample to be foreground, 
you would move the thumb on the slide bar or click the 
left end box of the slide bar to increase the Sample 
percentage and decrease the Clipboard percentage.

3) Click the Ok box to activate the settings or the Cancel box 
to leave the settings as they were when you entered the 
Mix Settings dialog.

*  Note:  The Mix Setting is saved in the Preferences file.

After selecting the Mix Settings, you’re ready to do the actual 
mixing.
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Mix
Select the Mix option to begin mixing the clipboard sample with 
the selected sample of the active window.

When mixing segments, keep in mind the following rules:

◊ The mix option will be inactive until you have a 
segment selected in the active window.

◊ Listen to the clipboard sample before mixing using the 
Play Clipboard command (  -*) under the Setup menu.

◊ Samples recorded at different rates will be mixed at the 
different rates and may sound peculiar together.

◊ You can undo a mix immediately after use the Mix 
command.

◊ If the clipboard sample is shorter than the selected 
segment, it will end before the selected sample ends.

◊ You will need enough memory to copy the sample you 
want to mix to the clipboard.

◊ Mixing the clipboard contents with a selected segment of 
a file will not increase the size of the file.

Select All ( -A)
Select All has the same effect as dragging the selection bar from 
the sound graphs beginning to its end. If you notice that the 
Select Region shows only half the value shown on the cassette 
label after you’ve used Select All while the file is in Full View, 
this is because you’re working with a stereo file. The cassette 
label shows the total bytes of Channel 1 and Channel 2 
combined.
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CHAPTER FOUR

The ‘View” Options

Zooming
In the Zoom modes, described below, you can magnify portions 
of the sound pattern. In these enlarged views, you can select 
very small parts of the wave and use the edit functions to fine 
tune the file--cut out unwanted noise or unwanted silence, fine 
the exact location at which a sound begins, piece together sounds 
without popping, etc. As you zoom, the calculated number of 
samples per pixel will be displayed next to Resolution on the 
screen.

Zoom ( -M)

Use the Zoom option to magnify a selected portion of the sound 
wave to fill the sound graph window.

Zoom In ( -+(plus))

Select Zoom In to condense the view of the wave by 1/2. The 
wave is condensed from the beginning.

Zoom Out ( --(minus))

Steps you back from the wave giving you a wider view.

Full View ( -p)

Choose Full view to display the file’s entire wave on the screen.

Oscilloscope
Choose Oscilloscope to set your input levels before recording. 
The Oscilloscope gives you real-time feedback in response to 
your input. Use the record level bar at the bottom of the 
window to change your record level. You can also reset your 0 
point to adjust for your particular card. With no input to the 
card, the zero level should be fairly straight across the second 
line from the bottom on the oscilloscope grid.

Click:

◊ Channel 1 to see the input to Channel I (Left).

◊ Channel 2 to see the input to Channel 2 (Right).

◊ Pause to freeze the wave momentarily. Click Pause
again to continue real-time monitoring.

◊ and drag the Record Level thumb to raise (right) or lower (left) the record 
level.
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◊ and drag the Zero Adjust thumb to move the 
horizontal zero line up (right) or down (left). This 
setting has no affect on the recorded sound.

◊ OK when the record level is Set to your satisfaction.

The Oscilloscope option

Change Color
Select this from the menu and you'll be presented with a color 
palette. Click on any of the four squares to change that color. 
Adjust the color using the Red Green and Blue slide bars.

Click on the box 
whose color you 
want to change

The Change Color option
Click:

◊ Default Color Table to return to the default Sonic
Blaster colors.

◊ Cancel  to return to the colors set before choosing the 
Change Color option.

◊ OK when you've found a color scheme you like.

The next time you start the program, the Colors will be the same as when 
you last ran the program.
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CHAPTER FIVE

The “Effects” Options
The Effects options affect only the segment of the currently 
selected window that you have highlighted by clicking and 
dragging.

* Note: When working with stereo files, you can select 
the channel on which you want the effects to take place 
with the Effects Channel option in the Setup Menu. 
You're given the options Display Channel, and Both 
Channels. You can, for example, echo Channel 1 while 
Channel 2 remains unaffected.

The Effects Channel option cannot be selected when 
working with a mono file. In mono files, all effects will 
affect the single mono channel.

A m p l i f y . . .

First select the segment you want to amplify. Then select this 
option from the menu. A window will appear allowing you to 
select the percent of amplification (200% is twice as loud).

*  Note: When you increase the amplitude you also 
increase the level of noise you have recorded. For the 
cleanest sound, make sure that your recording levels are 
set high enough to capture the sound but not high 
enough to dip the sound. See Trouble Shooting in the 
Appendices.

Backwards
The selected segment will be flip-flopped. This is your chance to 
hear for yourself if there are any secret messages backwards-
masked into Rock-and-Roll songs. Play your own voice 
backwards. Who knows? Maybe you, yourself, are sending out 
messages so subtle you didn’t even notice.

Echo.. .
A window will appear allowing you to set the Echo 
Amplification and the Echo Interval.
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Echo dialog box

◊ Echo Amplification determines how loud the echo 
will be.

-> 50%, the default setting, is a good setting for most
echos. each echo is at half the volume of the
previous.

-> A Setting of 100, will echo the sound at full
strength.

-> Settings above 100 will make it sound like the echo
is coming toward you. If echoed long or loud
enough, the sound will be clipped.

◊ Echo Interval determines how much of the selected
segment will actually be echoed. Echos are usually
referred to in time intervals:

-> A 1/8 second echo is about equal to the resonance
in a bathroom.

-> A 1/4 second echo is like the echo in a large
hallway.

-> A 1/2 second echo is like the reverberation in a big
auditorium.

-> A  1 second echo is like yelling in a canyon.

Decide how you want your echo to sound, divide the 
current playback by 8,4, 2, or 1 and then set Echo 
Interval to that number.

A couple of things to keep in mind:

-> If you set the echo interval to a number larger than 
the selected segment, nothing will happen.

-> On the longer echos, you’ll need to leave some 
space for the sound to echo into.
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Fade Down
Fade Down will modify the selected segment to sound as if the 
volume was gradually turned down toward the end of the 
segment.

Fade Up
Fade Up will modify the beginning of the segment to make the 
amplitude start low and build as if the volume was gradually 
turned up.

Phase Shift
Phase Shift is for stereo waves. This effect gives you the same 
result as reversing the positive and negative speaker wires of 
one stereo speaker. Normally, stereo speaker cones move in and 
out similarly (in phase). When you reverse the wires of one 
speaker, it reverses the phase of that speaker so that when a 
phase pushes one cone out, the other cone is moving back. This 
creates what is called an ambient effect.

Phase Shift lets you reverse the phase of one channel without 
changing the speaker wires. Try it out and hear the difference.

1) Open a stereo file.

2) Select the Effects Channel option under the Setup 
menu.

3) Choose Display Channel from the Effects Channel dialog 
box.

4) Click the Ok box.

5) Select the entire sample or the segment of the sample 
you want to phase shift.

6) Select the Phase Shift option.

7) Play the sample.

shift
Select the Shift option to change the zero level of a selected 
segment. Use the Shift option to match zero levels of two 
segments and avoid the audible “click” that is played when a 
sample makes a jump from one zero level to another.

1) Select the entire sample or the segment of the sample 
you want to shift.
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2) Select the Shift option. The Shift dialog box (below) 
displays the viewable portion of the screen.

Shift dialog box

3) Use the up and down slide bar to raise or lower the zero line.

4) Click the Ok box to shift the selection to the chosen level or 
click the Cancel box to return to the active sound
graph.

When using the Shift option, keep the following things in 
mind:

◊ The Shift option will be inactive until you have a
segment selected in the active window.

◊ The Shift option affects only the zero level; it doesn’t 
affect the rate.

◊ Shifting the zero level does not remove noise. It can,
however, introduce noise if the phase is shifted too high 
or low

Silence
Silence replaces the selected segment with the sound of 
nothing; a sound like you've never heard before.
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CHAPTER Six

The “Setup” Options

* Note; Channel 1 is the same as Left and Channel 2 is the
same as Right on most stereo setups.

Playback Channel. . .

You can choose to playback through Channel 1 (left), Channel 2 
(right), or Both Channels. Cancel leaves the settings as they were 
before you choose the option.

Record Channel...

This option lets you select which channel you want to record 
from.

◊ Recording on both channels (stereo) cuts the maximum 
Record Sample Rate down from 30,368 to 15,184.

◊ If you have your input device set up for mono input, 
and Set the Record Channel to Both Channels, you’ll 
be recording sound on one channel and silence on one 
channel.

* Note; Most mono inputs feed to channel one. The VU 
meter will show which channel is getting the input.

If you have a microphone inputing to Channel 1 and 
have the Record Channel set to Channel 2, you’ll be 
recording silence.

◊ Sounds recorded on only one channel (mono) can be 
played back through both channels using the Playback 
Channel setting.

Effects Channel. . .

To activate this option, you must be working with a stereo 
recording. Use the Effects Channel option to dictate whether the 
Effects you select will affect both channels or just the channel 
currently displayed. Using this option, you can play a segment 
from one channel backwards while leaving the same segment 
on the other channel the same.

Ch. 6-The "Setup" Options 41

Download from Www.Somanuals.com. All Manuals Search And Download.



Auto Gain
You must have some form of input to use this option. Auto 
Gain will set the record level for you. This feature automatically 
adjusts the level according to the highest input to help eliminate 
clipping. Input the sound you’ll be recording, click Save to set 
the level, then proceed with your recording. Move the thumb to 
the right of the sound wave grid to manually set the maximum 
level for clipping. In general, set the level dose to the second 
row from the top of the grid. Experiment with the Clip Level 
setting to see what the different levels will do.

Play Clipboard ( -X)
The Play Clipboard option lets you hear the sample currently in 
the clipboard. The sample will play at the Playback Sample Rate 
set for the currently active window.

Use the Play Clipboard command to hear the clipboard contents 
before mixing. (Refer to the Mix command described earlier.)

Default Play Rate
This option will set the Playback Sample Rate back to what it was 
when loaded. Raw Data format files will be set to 22085 Hz. All 
other format files will be set to their original Playback Sample 
Rate.

Set Play to Record Rate
This is the easy way to set your Playback Sample Rate to the same 
setting as your Record Sample Rate.

Set Record To Play Rate
This is the easy way to set your Record Sample Rate to the same 
setting as your Playback Sample Rate. Use this option to 
match the playback speed of one file to the recording speed of the 
next sample you record. For example, you may have a file that 
was recorded at a very fast rate. To make your next recorded file 
match the fast rate, select Set Record To Play Rate and then 
record your new file. The new recording will be made at the 
currently set Record Sample Rate so the new rate will match 
the old rate. Now the two files can be edited together and won't 
sound like Mr. Bill meets Lurch.

Display Dots
This option replaces the sound graph’s lines with dots. It has no 
other affect on the file.
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CHAPTER S EVEN

The Sounds” Options

Display Channel 1

Shows the sound graph for Channel I of the current file.

Display Channel 2

Shows the sound graph for Channel 2 of the current file. This 
option will be disabled for mono files.

* Notes Unlike the Effects options, any Edit made to one 
channels graph will also be made to the other channels 
graph.

List of Open Sound Files

Pick the file you want to display from this list of currently open 
files.

* Note~ The program allows a maximum of eight files 
open at the same time. Your computers memory and 
the size of the files may mandate a smaller maximum.
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APPENDICES

The following appendices are included for further reference and 
reading enjoyment:

A - -  Copying Sonic Blaster to RAM, ROM or Hard Disk

B - -  Trouble Shooting

C - -  Adapters

D - -  The Introplay Program

E - -  Saving Large Files to Multiple Disks

F - -  Getting Help
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APPENDIX A

Copying Sonic Blaster to RAM, ROM or 
Hard Disk

The System

If you want to run Sonic Blaster from your RAM, ROM or hard 
disk, use the latest version of GS/OS. The GS/OS version we’ve 
included with the Sonic Blaster was the latest at the time the 
card was packaged. However, the Sonic Blaster disk does not 
contain all of the GS/OS files, just those system files needed to 
run the program and access any disk drives you may have 
connected. Check with your Apple dealer for GS/OS upgrades 
and documentation.

*     Notes: Do not use any system other than GS/OS.

Where’s the Program?

The Sonic Blaster program itself is contained in the 
SONIC .SYS16 file. The SBPARAMS file is created by the program 
and adjusted each time you Quit the program. It contains the 
program settings as they were when you last Quit the program. 
The settings saved are: Color, Volume, VU On or Of f, Record 
Sample Level, Record Sample Rate, Single or Continuous Play, 
and the Setup menu’s settings for Playback Channel, Effects 
Channel, Record Channel. and Auto Gain Clip Level.

Booting from the RAM Disk w/o Your Own System Loaded

To boot the program from a RAM disk, you’ll need to set up a 
RAM disk of at least 448K. If you have enough memory, you can 
create a RAM disk large enough to hold several sound files as 
well as the program. (Refer to your IIGS Owner’s Guide for 
direction on sizing the RAM disk.) However, keep in mind that 
the more memory you use as RAM, the less the program has to 
use to record and play sound files.

Initialize the RAM disk first and then copy the entire SB startup 
disk to your RAM disk.

If copying with the Finder, do not drag the icon of the Sonic 
Blaster disk onto the RAM disk icon. Instead:

1) Open the SB disk icon first
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2) Select All ( -A)

3) Drag all the files to the RAM disk icon.

This allows the computer to find the files it needs to boot.

* Note: Because this is an auto-start program, when you 
boot it from the RAM disk and Quit ( -Q), you'll just be 
returned to the program. You'll need to eject the disk 
and reboot the computer to run a different program.

From RAM, ROM, or Hard Disk W/ GS/OS Intact

If your RAM, ROM, or hard disk is already set up with GS/OS, 
simply copy the SONIC.SYS16 file from the Sonic Blaster disk to 
the volume.

If you want to keep the current settings intact (color, volume, 
etc.), you'll need to also copy the SBPARAMS file from the System 
directory of the Sonic Blaster program disk to the System 
directory of your boot disk.

You can also copy any sound files with which you plan to work 
onto the RAM, ROM, or hard disk if there is room.
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APPENDIX B

Trouble Shooting

Strange Behavior in General

When the Sonic Blaster doesn’t seem to be playing or recording 
properly, it’s probably do to a loose connection somewhere.

* Important! You must connect the mounting plate to the 
back panel of the computer for proper grounding. If you 
do not, Sonic Blaster cannot function properly. 

Check the cables connections to the card, to the motherboard 
and to the back panel. Check the cards connection to the 
expansion slot.

A quick and thorough visual inspection before calling Technical 
Support can save you both time and trouble.

Reversed Speakers

If you notice that the stereo sound from a game, music program, 
or other sound software is coming from the ‘wrong” speaker 
(left instead of right or visa-versa), simply switch the speakers or 
their plugs around. The Sonic Blaster uses the Apple standard 
left (Our channel 1) and right (our channel 2) output assignment. 
Some programs, however, have the channels reversed.

"Check startup device" message

If you’re trying to boot the program from a RAM disk, you must 
initialize the RAM disk before copying the program disks files 
onto it.

"Unable to load ProDOS" message

If you’re trying to boot the program from a ROM or RAM disk, 
the system folder must be on the main level (the root directory) 
of the ROM disk. If you dragged the icon of the program disk to 
the ROM or RAM disk (using the Finder), all the boot files will 
be in a folder of their own on the disk. You’ll need to open this 
folder, use the Select All option, and drag the folder’s contents 
to the ROM or RAM disk. You can then throw away the empty 
folder out of which you have moved the files.

App. B - Trouble Shooting 47

Download from Www.Somanuals.com. All Manuals Search And Download.



Distorted Sound
◊ Once again, is the SB’s connector plate screwed onto the 

back panel? Is the other end securely connected to the 
card? If not, the Sonic Blaster is not grounding properly.

◊ Is the E-I/O cable connected to both the Sonic Blaster and 
the motherboard?

◊ Check your speaker wires. Are all the connections 
secure? Are bare wires from the left and right wires or 
the power and ground touching?

◊ Are you clipping the sound? If the peaks of your sound 
waves are flattened against the top and/or bottom of the 
sound graph window (see below), you’re clipping. This 
results in distorted sound. Turn down your record 
level. Try using Auto Gain to set the record levels for 
you.

An example of clipped sound

Sonic Blaster’s Error Messages

Cannot Set  Record to Playback

The maximum Playback Sample Rate is higher than the 
maximum Record Sample Rate so the record cannot always be 
set equal to the playback rate. For example, if your Playback 
Sample Rate is set to 43382, the Record Sample Rate cannot 
match that setting.

Maximum number of windows opened

You’ll get this message when you have eight windows open 
and you try to open another with the Open, New, or Record 
commands. Close a few windows before proceeding.

Maximum of 2 Channels Supported

This error message appears when you try to open an AIFF 
channel that has been recorded with more than two channels. 
You won’t be able to open the file.
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Missing FORM/COMM/SSND chunk in AIFF fi le  
This is a seldom, if ever, seen, error message that appears when 
a sound file does not have some required information. You 
wont be able to open the file.

Must have a 64K block to record 
Must have a 128K block to record
If Max Block shows less than 64K, you’ll get this message when 
you try to record in mono. If Max Block shows less than 128K, 
you’ll get this message when you try to record in stereo. Even 
though you close files to free up memory, the CS memory 
manager may not join the newly freed pieces of memory 
together. This is the same reason that the Max Block setting 
may show you have 110K free before you record a l00K file and 
still show 90K free when you finish the recording; the memory 
manager does some memory resorting to put together and 
make available fragmented pieces of memory.

Only 8 Bit  Samples  Supported
AIFF supports more than S bit samples. Sound files created on 
the Macintosh, for example, may be 16 bit samples. You won’t 
be able to open the file.

Playback speed i s  too  fas t
When this message appears, the file segment is too small to be 
played at such a high speed. Slow down the Playback Sample 
Rate or select a larger segment of the file. (Entering and 
exiting the Control Panel while playing can also cause this 
error).

Requires AE Sonic Blaster Card
The program can’t find the Sonic Blaster card. Make sure the 
card is installed properly and that the slot containing the card is 
set to “Your Card" in the Slots option of the Control Panel.

Requires GS/OS Operating System
You’ll need to boot from a disk containing GS/OS before you 
can use the SB program.

Window must be open to Append
Before you can use the Append command, you must open a 
window with the Open, New, or Record command. The 
Append option will be enabled when you have a window 
open.

Window must be open to Paste
Before you can use the Paste command, you must open a 
window with the Open, New, or Record command. The Paste 
option will be enabled when you have a window open.
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APPENDIX C

Adapters

Speaker Connections

The Sonic Blaster uses the 1/8” stereo mini jack for input and 
output. This is the same jack used by most portable stereos.

The Bose Roommate speakers and several other brands use the 
1/8” jack and will need no adapters.

If your speaker wires (or wires from your amplifier) end in
phono plugs (often called RCA plugs), you’ll need the Stereo
Playback Y-Adapter. It adapts phono plugs to the Sonic Blaster’s
1/8” stereo mini jack. (Radio Shack Cat. No. 274-369.)

      From  Speaker Phono Plugs 
       Left and Right                                To Sonic Blaster “OUT” 
       (Ch1& Ch2)

RS Cat. No. 274-369 
Two Phono (RCA) Plugs to

1/8” Stereo Jack

If your speakers have button terminals (quick connect), you can
get two “mini phone plugs to stripped ends” and connect it to a
connector with “two 1/8” mono plugs to 1/8” stereo jack.” (2
cables--RS Cat. No. 42-2434 and I adapter--RS Cat. No. 274-375.)

From Speaker Wires
   Left and Right               To Sonic Blaster “OUT”
   (Ch1 & Ch2)

                RS Cat. No. 42-2434    RS Cat. No. 274-375
                         1/8” Phone Plug to                    Two 1/8” Mono Plugs to 
                            Stripped Ends                              1/8’ Stereo Jack

If you have a setup different from the ones mentioned, talk to 
your local Radio Shack person or stereo/electrical supplies 
person for the correct cables and adapters.
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CD, VCR, TV. Turntable and Amplifier Connections
If your VCR or TV has phono jacks for audio input and output, 
you can use a “mini phone plug to phono plug cable (RS Cat. 
No. 42-2444) for mono recording.

For Mono Record

To Audio “OUT’ of 
VCR. CD, TV, etc.                        To Sonic Blaster “IN”

RS Cat. No. 42-2444
Phone (RCA) Plug to

1/8” Phone Plug

If you have a stereo TV, or VCR or if your amplifier, CD player, 
tuner, or turntable has phono jacks for left and right input 
and/or output, use two of the same cables mentioned above and 
a connector with ‘two 1/8” mono plugs to 1/8” stereo jack.” (2 
cables—RS Cat. No. 42-2444 and 1 adapter—RS Cat. No. 274-375.)

                         For Stereo Record
To Audio ‘OUT” of 
VCR, CD, TV, etc.                                                                       To Sonic Blaster “IN”
Left and Right 
(Ch1& Ch2)

RS Cat. No. 42-2444    RS Cat. No. 274-375 
1/8” Phone Plug                  Two 1/8” Mono Plugs to
to Phono (RCA) Plug            1/8” Stereo Jack

If you can use the same connectors for output, double the order 
(4 cables and 2 adapters) and connect phono plugs to Audio “IN” 
and Sonic Blaster “OUT.”

If you have a setup different from the ones mentioned, talk to 
your local Radio Shack person or stereo/electrical supplies 
person for the correct cables and adapters.

Microphones
Chances are, you’ve got a microphone lying around the house 
somewhere; maybe from an old tape recorder, from your 
answering machine, or from your days in that garage band that 
could have made it big if the right people could have heard you. 
If you don’t have a mike around, you can buy a very 
inexpensive one at Radio Shack or at many drug stores and 
super markets.
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The microphones don’t need to be super high quality for voice 
recordings, but the higher the quality input, the better the 
recording (up to a point). Start out with a low-cost mike. (Try 
Radio Shack’s Windscreen Dynamic Omni--RS Cat. No. 33-2001.)

For mono input, a mike with a 1/8’ mini stereo plug does not 
need a Y-adapter.

For stereo input, either plug two mono mikes into a left and 
right mono adapter (two 1/8” mono plugs to 1/8” stereo jack” 
adapter--RS Cat. No. 274-375--see below) or try a dual head 
microphone (RS Cat. No. 33-1065).

ToMono Microphones 
       Left and Right  To Sonic Blaster "IN”

(Ch1 & Ch2)

RS Cat. No. 274-375
Two 1/8” Mono Plugs to

1/8” Stereo Jack

If your mike cable ends in a 1/4” plug, you can use the 1/4” 
phone plug to 1/8” lack (RS Cat. No. 274-047) for mono input.

To 1/4” Mono
Microphone Jack                             To Sonic Blaster “IN”

RS Cat. No. 274-047
1/4” Mono Plug to

1/8” Jack
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APPENDIX D

The Introplay Program

The file Introplay, found in the System/System.Setup folder 
(subdirectory) of the Sonic Blaster program disk, will play the 
sound file Introsound as the GS/OS startup screen is displayed. 
We’ve included an Introsound file but you can easily create 
your own.

To use the Introplay program when booting from RAM, ROM, 
hard disk, or any other boot disk, copy Introplay and 
Introsound from the System/System. Setup subdirectory of 
the Sonic Blaster program disk to the System/System. Setup 
subdirectory of your boot disk.

If you're booting the program from your copy of the SB program 
disk, Introplay is already in place.

To create your own intro sound, run the Sonic master program
and save the file you want as your intro sound to the
System. Setup folder in the System folder on your boot disk.
The file must be saved as an AE Format file called Introsound.

* Note:   If you do not have the program setup correctly, 
the computer will still boot but no sound file will be 
played during the boot.

If you’re using the Startpic program to load a picture during 
boot, the Introsound file will be played either before or after 
Startpic depending upon which appears in the boot disk’s 
directory first. If you want the picture loaded before the sound 
file is played, copy startpic to the boot disk before you copy 
Introsound to the boot disk. You may also use a disk utility, 
like ProSel, to arrange the order.
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APPENDIX E

Saving Large Files
to Multiple Disks

If you have a file that is larger than a single floppy disk, you can 
break it up into two or more files and save it to separate disks. 
You can then load it back into the program using the Append 
option under the File menu.

To break up a file into several files, follow these instructions:

1) Hold down the  key while clicking the mouse within the 
sound graph of the file.

This will select a portion of the file from the beginning to the 
point where you click the arrow.

2) Check the Select Region to see how much is selected.

3) Continue to hold down the  key while dragging more 
to the left or right within the sound graph until you 
have selected a region the size you want to save. 
Release the mouse button and  key.

4) When you have the right size, Cut 
it ( -X). 
This moves the selected segment to the clipboard.

Don’t use the Copy command to move the segment to the 
clipboard. You need to remove the segment from the sound 
graph window.

5) Open a New file ( -N).

If you’re segmenting a stereo file, your Record Channel should be 
set to Stereo Record before opening a new file. Otherwise, the two 
channels will be combined into one mono file.

If you’re segmenting a mono file, set the Record Channel to  
Channel 1 or Channel 2 before opening the new file. If you set 
the Record Channel to Stereo Record, the mono file will be 
pasted into both channels (not true stereo; just split mono) and 
the size of the segment will be doubled.

6) Select All ( -A).

7) Paste ( -V) the sound segment into the sound graph 
window
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The ‘silent wave used to create the window will be replaced 
with the clipboard contents.

8) Save ( -S) the file to whatever disk you want. (Refer to 
the Save instruction in Chapter 2 if you don't know 
how to change volumes, etc.

End the file’s name with the sequence number, for example, 
Laughs.I will be your first save, Laughs.2 your second, etc. This 
will help you keep track of the files’ order to make Appending 
easier.

9) Close the window you have just saved.

10) Return to the window you are segmenting.\

11) Check the size of the remaining segment as indicated on 
the cassette label.

-> If the Select Region is too large to Save to your 
other disk, repeat the steps above.

-> If the Select Region shows a size that can be saved 
to disk, use the Save As command to rename the file 
with the sequential number (Ex: Laughs.2). This 
saves the extra steps of cutting, opening a new 
window, selecting all, etc.

Segmenting is complete. You can now load the entire file back 
into the program by opening the first file (File. 1) then 
Appending the other files in sequence (File .2, File.3, etc.).
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APPENDIX F

Try This!
(Tips and Hints)

Record Sample Rate
When deciding at what rate to record a sample, keep in mind 
that the higher the sampling rate, the higher the sound quality 
but the more memory used. We recommend that you 
experiment to find out how the quality differs with lower 
sampling rates for both voice and music recording. Notice that 
the sound quality of voice recordings don’t improve much 
above a record rate of about 7,000 Hz while music sound quality 
drops dramatically when recorded at the lower rates.

In general, voice recordings require lower sample rates (around 
7,000) while music (especially from CD’s) require higher sample 
rates (we recommend the maximum, 15,184 for stereo and 30,368 
for mono).

Stereo or Mono?
When deciding whether to record a file in stereo or mono, 
consider these points;

◊ Do you have a stereo signal?

If you have only a mono signal, there is no reason to record in 
stereo; mono recordings can play back through both speakers.

◊ In the stereo mode, your maximum record rate is cut in half (from 
30,368 Hz to 15,184 Hz) although you can still play back at the 
max. sampling rate.

◊ If you want control of both left and right channel
outputs of a mono recording, you can:

1) Record the input in mono.

2) Paste it to a blank stereo file.

3) Edit the left and right channel separately. (See 
"Effect Channel” p.41.)

This allows you to record and play back at a higher 
sampling rate than if you make the recording in stereo. 
(See also, “Traveling Sound” p. 56.)
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Fun Stuff
You’ve probably had a chance to mess around with the Sonic 
Blaster software by the time you read this; we have, too. Here 
are a few things we’ve tried at Applied...

Back Talk

Record a word or phrase forward, listen to it backwards, record 
yourself saying it backwards and then flip it. How close can you 
get it to sound like an intelligible word or phrase? One phrase 
that sounds clear when reversed is “eem pleh” (‘help me).

*  Notes Remember that you’re working with the way 
words sound (phonetics), not the way they look; spelling 
a word backwards and reading it will usually not sound 
intelligible when flipped around.

Traveling Sound

If you’ve played the Left . Cen . Right file through stereo 
speakers, you’ve noticed that the sound moves from the left 
speaker to the middle and then to the right speaker (hence the 
name Left . Cen . Right). Look at Channel I and 2 of the file. 
Notice that Channel I has the first drum beat, Channel 2 has the 
third drum beat, and both channels have the second drum beat.

You can make even mono files “travel” in this manner by 
copying them into a stereo window, setting the Effects 
Channel to Display Channel, then pasting in silence over a 
section of the sound wave at the beginning of Channel One and 
at the end of Channel 2. Using this technique you could record a 
joke in mono, then have the left speaker ask the question ( e x :
Why are 5 and 6 afraid of 7?) and have the right speaker answer 
(Because 7, 8,9 and 10).

Answering Machines

Are people complaining about how boring your answering 
machine messages are? Well, with a Sonic Blaster, some stutter, 
and a little echo, even the most commonplace “I’m sorry. We 
can’t come to the phone right now  comes alive!

Some answering machines allow external inputs for leaving 
messages. If yours does, it may be possible to connect the SB 
directly to your machine. If not, place the machine near the SB 
speakers, begin recording with your answering machine and play 
the file you’ve created from Sonic Blaster.
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More Phone Fun

Hey Dad—I’m in jail

Imagine the surprise your parents will get when you call them 
from jail (any police show will give you some good background 
noise). Imagine the look on your child’s face when he/she gets a 
call from Alvin and he actually calls them by name (fast playback 
rate). Imagine how envious your friends will be when you call 
them from your new car phone (highway ambiance, honking 
horns, maybe even a crash). We’re not saying that you should 
try any of these; but just imagine!

‘It’s a floor  wax and a dessert topping

Ever talk to obnoxious phone salespeople who only let you say 
‘Yes’ or “No”? Now you can let Sonic Blaster do the talking for 
you. Record a “Yes” and “No” then select and play the 
appropriate one. After you’re used to this, throw in a “Please, 
tell me more!” and an “I’m not interested” for variety. Play 
them at slower playback rates to send chills up their spine. 
When they ask, tell them you live on Elm Street and your name 
is Fred.

Twistin’

Tired of tangling your tongue with twisters? Let Sonic Blaster 
say them faster. Record yourself saying a tounge twister once (ex:
The slick shiek’s sixth sick sheep) and then hit continuous play 
and increase the playback rate. Toy boat, toy boat, toy boat, toy 
boat...
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APPENDIX G

Programmers’ Reference

* Note:  This chapter contains technical information for 
programmers interested in programming the Sonic 
Blaster. It is not a programming tutorial, If you're not a 
programmer you should ignore this information. Don't 
look at it. Don’t even think about it. The card will run 
fine without knowing what’s under the hood.

Identify the Sonic Blaster

The card resides in the following memory locations:

$CN00 ——> $5B
 CNO1 ——> $5B
  '
  '
  '
  CNFF  ——> $5B

AE File Format

The AE File Format attaches an ID header with the following
information to the sound file.

F i l e s  Binary Notes

ID $4145504D ‘AEPM'
ASCII 4 byte MSB off

Type 2 bytes 0—AE Format
1—2:1
2—2.67:1

Channel 2 bytes 0—Mono
1—Stereo

Length 4 bytes Length of sampled Sound
(per channel) does not
include header

Frequency 2 bytes In Hz

Following the header is Channel 1 sampled data.
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Notes About
Files Binary Info Example File

ID 'AEPM'
Type      0 AE Format
Channel      0 Mono Recording
Length      10246 10,246 byte file
Freq 30368 Recorded at the Highest SB

Record Rate
10,246 8-bit 
samples 

In the case of stereo files, Channel 2 sampled data immediately 
follows Channel 1 sampled data and does not require a separate 
header.

Refer to the Apple Standard Sound File Format (SSND) 
documentation for complete AIFF format information.

Setting Gain and Channel For Input
When setting gain and channel for input, write to the following 
hardware location:
$C0n*16+$81 (write/read)

The format of the byte to write is:

| 7   6   5   4   3   2   1   0 |
       x    x |                          |
                     Gain - 0-31
0 - Ch 1 0 - low level gain for high input
1 - Oh 2 31 - high level gain for low input

* Note: Bits 5 and 6 are not used.

This is all the information provided by the program. The rest is
done through the Ensoniq chip. Refer to the IIGS Hardware
Reference Manual for information about digitizing with the
Ensoniq.
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APPENDIX H

Getting Help
If you have a technical question relating to your Sonic Blaster 
card or any other Applied Engineering product that is not 
covered in the manual please contact the dealer from whom 
you purchased the product. If you are experiencing difficulties 
with one particular program, contact the programs author or 
publisher.

In the event that the dealer or the publishers support personnel 
cannot answer your question, call Applied Engineering 
Technical Support. The support representatives are experienced 
in the applications and uses of Applied Engineering products, 
but in order to provide a quick and effective answer to your 
question, they will need to know as much as possible about the 
hardware and software specifically related to your question. 
Please provide the technical support representative with the 
following information:

◊ The Applied Engineering product related to your 
question and its revision number.

◊ The original and current memory configuration of the 
card (if applicable).

◊ The model and revision of your computer.

◊ What peripherals are being used and what cards are in 
each slot.

◊ The name, version, and revision level of the software 
with which you are experiencing problems.

◊ The results of any test programs, diagnostics, or 
troubleshooting done by you, your dealer, or your 
software publishers support department.

Applied Engineering
Technical  Support

( 2 1 4 )  2 4 1 - 6 0 6 9
9AM to 12:30 PM & 1:35 PM to 5 PM(CST) Monday — Friday 
(Please call only the number above for technical support. Our

sales office cannot transfer calls to the support lines.)
Bullet in Board System

( 2 1 4 )  2 4 1 - 6 6 7 7
24 hours, 7 days a week

300/1200/2400 Baud, 8 Bit, No Parity, Full Duplex, MNP-5
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Returning a Product
RMA Number , “Attention" Sheet, and Invoice

If your product needs to be returned, the technical support 
representative will give you a Return Material Authorization 
(RMA) number.

◊ Record the RMA number for your own records.

◊ Write the RMA number on your package label.

◊ Fill Out the Return Form on back of the yellow sheet 
marked “Attention!’ A complete form will greatly 
reduce the time it takes to return your package.

◊ Attach a copy of your original invoice to the form.

* Warning~ If you don't include an invoice, products will 
be treated as out of warranty products and will be 
returned to you C.O.D. for the amount of the service 
charge.

A completed form should look something like the one below.
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Packing

If you don’t have the original packing material, wrap the board 
in anti-static material (preferably the anti-static bag in which the 
card was originally shipped; however, aluminum foil will work 
fine). Pack it in a sturdy box cushioned with wadded papers (i.e. 
used computer paper or newspaper).

* Warning:  If your product is damaged due to inadequate 
packing, your warranty will be void.

Include the return form and invoice.

Send the package, shipping prepaid, to:

RMA#__?__
Appl ied Engineering
Technical  Support
3210  Be l t  L ine  Road,  Sui te  154
Dal las  TX 75234

You should insure your package. Æ will not assume any 
responsibility for inadequate packing or loss or damage during 
shipping.

When We Receive

Our service department will use your completed form in an 
attempt to duplicate the problem.

If it is determined that your product is defective due to a 
manufacturing defect, your card will be repaired or replaced at 
Æ's Option.

Any misuse, abuse, or non-Æ authorized alteration, 
modification, and/or repair to the Applied Engineering product 
will void the warranty. This warranty will also be void if you 
use the Æ product for any purpose other than its intended use.

Your product will be fully tested before it is shipped back to you, 
transportation prepaid, via UPS regular delivery.

Once your product is received by Technical Support, it will be 
processed and delivered to our shipping department within 7 to 
10 working days.
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Glossary

AE Format -  Sonic Blaster defaults to the AE format for saving files. 
Information about the files record rate is saved along with the binary 
information so that when the file is loaded back into the program, it will be set to 
the same speed as it was recorded.

AIFF -  This is Apples standard sound file format.

Append - The Append option will open a file and attach it to the end of the file 
that is currently open. Use this option to quickly piece back together a file that 
you have stored to different disks or to stick together two different files. The first 
file opened will determine the playback setting for the appended files.

Auto Gain  -  This setting, under the Effects menu, will automatically set the 
recording level for the sound being received. This helps to eliminate clipping
(see below). You can’t record from the auto gain window. Send the loudest part 
of segment of the sounds to be recorded to the Sonic Blaster while in the Auto 
Gain window, click Save to set your levels, and then record from the main 
screen.

C l i p p i n g - Clipping occurs when your input is too ‘hot.” (“hot” meaning intense 
in a bad way, not “hot” as in “cool,” “hep,” “happening”). Clipping is evidenced 
by wave forms that flatten out at the top or bottom of the sound graph. Lower 
the input level or record level to prevent clipping. The Auto Gain option is also 
an effective way to keep from dipping (see above).

Compressed Fi les  -  These are files that have been in a form which reduces the 
amount of space required to store them. One disadvantage to compressing files 
is that during the compacting, a small amount of fidelity may be lost. This loss is 
negligible for the most part. Try compressing some files and playing back the 
compressed and non-compressed and listen for a difference.

Mini Stereo Jack  -  The mini stereo jack is the connector used on Bose
Roommate speakers, Sony Walkman, and many other portable stereo systems.
This jack is becoming more popular because of its compactness. It incorporates
the left and right inputs into one connector.

O s c i l l o s c o p e  -   Sonic Blaster’s oscilloscope lets you see a real-time waveform of 
the input received from the device connected to SB’s input connector. You Can’t 
record from the oscilloscope screen. Set your record level in the oscilloscope 
window (for both channels if recording in stereo) and then click OK to return to 
the main screen where you can begin the recording.
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Pathname  - A pathname is a path of directories required to access a specific file 
on a disk device. To reference a file named MYDATA on volume /MY.DISK you 
would use a ‘path’ to the file /MY.DISK/MYDATA. Some files may be additional 
directories and those directories may contain references to more files or more 
directories. The main volume directory is called the ‘root directory.” Directories 
within the root directory are called subdirectories. If you want to refer to a file 
contained in a subdirectory, you must include those intermediate subdirectory 
names in your full pathname. Say you have a volume called STREET and have a 
subdirectory called HOUSE and have a file called ROOM the complete pathname to 
access the file ROOM would be /STREET/HOUSE/ROOM. See: Prefix.

Phone Plugs /Jacks  - Phone plug (male connector) or jack (female connector) is a 
single prong or single hole connector. The difference between the phone and 
phono connectors is that the phono connectors have a circular metal extension 
around the plug or hole.

Phone Plugs /Jacks  - The phono plug (male connector) or jack (female 
connector), also called RCA plug/jack, is used by many record players, tuners, etc. 
for connecting one to the other. It has a single prong or hole with a circular 
metal extension around the plug or hole.

Playback Rate  - The rate in Hz (samples per second) at which the file is played. 
You can change the Sonic Blasters Playback Sample Rate setting even while the 
file is being played. A higher playback rate heightens the pitch and speed (think 
helium). A lower playback rate lowers the pitch and speed (think horror films).

Prefix  - The ProDOS prefix is a standard default partial pathname that is added to 
any file name you specify if your pathname is not fully qualified. A fully 
qualified pathname is one that starts with the volume name followed by any 
subdirectories that must be accessed to find the file in question. A prefix is used 
to shorten the amount of typing you must do to specify a pathname to a file. As 
an example, suppose you have a volume called NATION and that volume has a 
subdirectory called STATE and you have a program file called CITY that is in the 
STATE subdirectory. Without a prefix, you would have to use 
/NATION/STATE/CITY as the pathname to your file. You could, however, Set the 
prefix to /NATION/STATE and then you would only have to specify CITY as your 
pathname; /NAT ION/STATE would be automatically attached to the front of the 
pathname you specified.

Prefix Directory - The Prefix Directory is the directory specified by the current
ProDOS prefix; i.e., if the prefix is set as /MY . DISK/GAGES then the Prefix
Directory would be the subdirectory called “GAMES” found in the /MY.DISK

volume directory.
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RamKeeper - RamKeeper an Applied Engineering board which allows you to set 
up your IIGS memory card as an electronic hard disk.” This means you can load 
programs and data files at a super-fast rate from RAM without having to insert 
and swap disks. Programs and data files can be retained in memory even after 
the computer is shut off for instant access next time you power up.

Raw Data - This is one of Sonic Blasters Save As.. . formats. In this form the 
file is saved as straight binary information. Information, such as the rate at 
which the file was recorded, will not be saved. You may want to save files in this 
format to playback through a desk accessory that plays sound files. For this 
purpose, you may want to determine at what speed the DA plays the binary files 
and record your sound at that rate.

RCA Jack - The RCA plug (male connector) or jack (female connector), also 
called a phono plug/jack, this connector is used by many record players, tuners, 
etc. for connecting one to the other.

RESET - If you get yourself into a part of the program and can’t leave, then as a 

last resort you can usually use a -RESET command. You execute this feature 

by holding down the  and RESET keys simultaneously, followed by releasing 
the RESET key.

* Warning:  If you use this option while a program is
trying to write to disk, you may damage the data on your 
disk.

Sampling Rate  - This is the speed at which the computer takes information from 
the sounds that are being sent to it. A faster sampling rate means higher quality 
because the computer is recording more information in a given amount of time 
than it does at a slower sampling rate. In general, use lower sampling rates for 
voice (because there isn’t a lot happening during a voice input) and higher for 
music (because there’s a lot going on). Refer to “Record Sample Rate” in 
Appendix F for suggested sampling rates.

VU Meter - VU stands for Volume Units. The two meters on the screen give 
you a visual representation of the input levels the Sonic Blaster receives. Like 
the Oscilloscope, the VU meter is an effective tool for setting the record level.

Waveform -  In relation to the Sonic Blaster, a waveform is a graphic 
representation made up of binary information derived from samples in the 
digitized recording.
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